Smartes Prototyping

ELV Erweiterungsmodul NodeMCU - ELV-EM-NodeMCU

Das ELV-Modulsystem bietet eine groBe Vielfalt an unterschiedlichen Applikationsmodulen zur Erfassung diver-
ser MessgroBen wie z. B. Temperatur, Luftfeuchte, Helligkeit, Position oder Beschleunigung. Mit dem ELV Erweite-
rungsmodul NodeMCU (ELV-EM-NodeMCU) ist es nun auch méglich, die Applikationsmodule in Kombination mit einem
NodeMCU-Entwicklungsboard zu verwenden. In diesem Beitrag werden zunachst die Grundlagen der NodeMCU er-
lautert und das Schaltungsbild des Erweiterungsmoduls dargestellt. AnschlieBend wird die Programmierung in der
Arduino IDE beschrieben anhand der in Bild1 zu sehenden ELV Applikationsmodule Temperatur und Luftfeuchte
(ELV-AM-TH1)[1], Luxmeter (ELV-AM-LX1)[2] und Luftdruck (ELV-AM-AP)[3]).
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Infos zum Bausatz
ELV-EM-NodeMCU

Schwierigkeitsgrad:
leicht

Bau-/Inbetriebnahmezeit:

ca.0,26h

Besondere Werkzeuge:
keine

Loterfahrung:
nein

Programmierkenntnisse:

ja(Arduino-Programmierung)

Elektrofachkraft:
nein

Was ist eine NodeMCU?
Der Begriff ,NodeMCU” beschreibt sowohl eine Hardwareplattform als
auch eine Softwarebibliothek. Beide Komponenten basieren auf einem
ESP8266- oder ESP32-Controller des chinesischen Unternehmens
Espressif Systems, der sich vor allem durch einen glinstigen Preis und
einintegriertes WLAN-Modul auszeichnet[4]. Das Board ist daherideal
fur die prototypische Umsetzung neuer Hard- und Firmwarekonzepte.
Hardwareseitig unterstitzt der Mikrocontroller des NodeMCU-
Entwicklungsboards ein breites Spektrum an Seriellen Schnittstellen
wie I2C, SPl oder UART. Uber GPIO-Pins (General Purpose Input Output)
konnen Sensorenund Aktorenangeschlossen werden. Zu den weiteren
Komponenten gehoren eine USB-Schnittstelle zur Spannungsversor-
gung und Programmierung, ein UART-zu-USB-Wandler fiir die seriel-
le Ausgabe von Sensordaten, ein Spannungsregler zur Regelung der
Eingangsspannung auf 3,3V sowie zwei Taster flr das Aktivieren des
Bootloader-Modus und das manuelle Zurlcksetzen des Boards.
Firmwareseitig existieren durch eine groBe Community bereits viele
Libraries fur die Programmierung der NodeMCU. Am haufigsten erfolgt
die Programmierung in Arduino, da die Syntax und Entwicklungsum-
gebung einen leichten Einstieg ermdglichen. Dartber hinaus werden
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jedoch u. a.auch C/C++, Lua-Script oder Python un-
terstitzt [5].

Das ELV Erweiterungsmodul NodeMCU wurde
fir die Joy-IT Entwicklungsplatine NodeMCU mit
einem ESP-WROOM-32-Mikrocontroller entwickelt
- generell ist sie jedoch auch mit allen anderen
NodeMCU-Boards mit ESP32-Mikrocontroller kom-
patibel. Dieser Nachfolger des ESP8266 bietet ne-
ben dem WLAN-Funkmodul auch eine Bluetooth-
LE-Schnittstelle und mehr GPI0-Pins [6].

Bild 2 zeigt exemplarisch die Draufsicht auf die
Joy-IT NodeMCU [7]. Auf dem PCB (Printed Circuit
Board)sind die zuvor genannten Komponenten farb-
lich gekennzeichnet:

- gelb: ESP-WR0OOM-32 SoC (System on Chip) mit

Tensilica-LX6-Dual-Core-Prozessor
« blau: UART-zu-USB-Wandler(Silicon Labs CP2102)
- grin: Spannungsregler (TI LM1117)

« grau: Bootund Enable Buttons
- orange: Micro-USB-Buchse (Spannungsversor-
gung und Ubertragung der Firmware)

Schaltung

Die Schaltung des ELV Erweiterungsmoduls
NodeMCU (Bild 3) verbindet alle relevanten Pins der
Applikationsmodule des ELV-Modulsystems mit der
NodeMCU. Das Erweiterungsmodul wird dabei Gber
die StiftleistenJ1und J2 auf die Applikationsmodule
gesteckt, wahrend die Buchsenleisten J3 und J4 fur
die Aufnahme der NodeMCU-Entwicklungsplatine
vorgesehen sind.

Fur die Spannungsversorgung der Applikations-
module sind die Pins 14 (GND), 16 (VDD =3,3V) und
17 (GND) der Buchsenleisten J3 und J4 mit den
gleichnamigen Pins der Stiftleisten J1 und J2 ver-
bunden.

Bild 2: Draufsicht Joy-IT Entwicklungsplatine NodeMCU mit ESP32

Bild 1: NodeMCU mit ELV Erweiterungsmodul NodeMCU und aufgesteckten Applikations-

modulen (ELV-AM-TH1, ELV-AM-AP, ELV-AM-LX1)
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Bild 3: Schaltbild des ELV-EM-NodeMCU
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Bild 4: Platinenfotos und Bestlickungsdrucke des ELV Erweiterungsmoduls NodeMCU

Hinweis

Eine gleichzeige Versorgung der NodeMCU und
der angeschlossenen Applikationsmodule Uber
USB und die VDD-Pins sollte vermieden werden,
da es durch unterschiedliche Spannungen und
dem daraus resultierenden Strom zu Beschadi-
gungen der Schaltung kommen kann! Um solche
Probleme zu vermeiden, ist es wichtig, dass die
Stromversorgung eindeutig definiert ist und
keine Mehrfachversorgung stattfindet.

Im Bereich der Seriellen Schnittstellen sind zwei
UART-Schnittstellen nutzbar. Die Pins RX0 und TX0
dienen zur Ubertragung von Firmware und Debug-
Informationen. Falls das angeschlossene Applika-
tionsmodul seine Daten Gber UART bereitstellt, ge-
schieht dies Uber die Pins RX2 und TX2, die mit Pin
19 und 20 von J1bzw. J2 verbunden sind.

Ebenfalls verfligbar ist ein SPl-Interface, bei
dem die Pins D18 (SPI_SCK), D19 (SPI_MIS0) und D23
(SPI_MOSI) auf die Pins 22, 23 und 24 von J2 gefiihrt
werden. Am Pin D5 der NodeMCU muss wahrend
des Startvorgangs ein High-Pegel anliegen. Soll-
te eine weitere angeschlossene Peripherie einen
Low-Pegel an D5 erfordern, kann tiber den Jumper
Jb alternativ der Pin D32 auf den SPI_CS Pin (Pin 21
an J2) gefiihrt werden. So ist eine korrekte Funk-
tionsweise des SPl-Interfaces sichergestellt. Die
I2C-Pins D21 und D22 sind mit den Pins 7 (I2C_SDA)
und 8 (12C_SCL)verbunden.

Bild 5: Abschluss der Arduino-IDE-Installation
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Zu den weiteren Verbindungen gehdren die zwei ADC-Pins D25 und
D26, die mit Pin 17 und Pin 18 verbunden sind. Der ADC-Pin D13 kann
funktional zum Auslesen der Batteriespannung genutzt werden.

Nachbau

In Bild 4 sind die Platinenfotos und Bestickungsdrucke des ELV Erwei-
terungsmoduls NodeMCU zu sehen. Da alle Bauteile bereits bestlickt
sind, sind keine Lotarbeiten notwendig.

Installation und Vorbereitung der Entwicklungsumgebung
Hinweis: Die nachfolgenden Installationsanleitung bezieht sich auf die
Arduino IDE in der Version 2.1.0 und das Betriebssystem Windows 11.

Falls die Arduino IDE noch nicht installiert ist, kann diese von der
offiziellen Arduino-Webseite kostenlos heruntergeladen werden [8].
Durch das Befolgen der angezeigten Installationsschritte sollte am
Ende derin Bild 5 zu sehende Dialog erscheinen.

Fir die Verwendung der NodeMCU wird die offizielle ESP32-Biblio-
thek benotigt, in der die Boarddefinitionen enthalten sind. In der Ar-
duino IDE kann der zusatzliche ,Boards Manager” Giber das Menti File >
Preferences hinzugefligt werden. In das Feld ,Additional board mana-
ger URLs"” wird die folgende URL eingetragen (Bild 6)[9]:

https://raw.githubusercontent.com/

espressif/arduino-esp32/gh-pages/ <

package_esp32_index.json o

Durch Betatigen des Buttons ,0OK" schlieBt sich der Dialog. Die IDE ent-
halt nun eine weitere Quelle im Boards Manager. Zur Installation der
Boards wird der Boards Manager aus der Seitenleiste ausgewahlt. Dort
kann nun durch den Suchbegriff ,esp32” das entsprechende Package
von Espressif Systems heruntergeladen werden (Bild 7).

Fur die korrekte Nutzung der UART-zu-USB-Schnittstelle muss
der CP210x-Treiber installiert werden. Dieser steht auf der Website
von Silicon Labs zum Download bereit [10]. Die Ausfiihrung der Datei
.CP210xVCPInstaller_xB64.exe” startet den Geratetreiber-Installations-
Assistent (Bild 8). Durch das Befolgen der Installationsanweisungen
werden nun automatisch die bendtigten Treiber installiert.

Nach dem allgemeinen Vorbereiten der Entwicklungsumgebung
konnen nun die Bibliotheken fir die Nutzung der Applikationsmodule
eingebunden werden. Zur Nutzung des Applikationsmoduls Luxmeter

Sonstiges:
Stiftleiste, 1x 12-polig, gerade, SMD J1,J2
Buchsenleiste, 1x 15-polig, gerade, SMD J3, J4
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Bild 6: Hinzufligen einer neuen Boards-
Manager-URL

steht im Downloadbereich des ,ELV Bausatz Lichtsensor OPT3001 mit
I2C-Schnittstelle 12C-LS” [11] der Ordner ,Software Arduino Beispiel-
paket”zur Verfligung.

Nach dem Herunterladen befindet sich in dem Verzeichnis neben
der 12C-LS-Bibliothek auch eine Readme-Datei, die verschoben bzw.
geldscht werden muss, da es sonst zu einer Fehlermeldung beim Im-
portvorgang kommt.

Bild 8: Installation des CP210x-Treibers

Bild 7: Installation des
esp32-Package

Inder Arduino IDE wird nun aus der Mentleiste der
Punkt Sketch = Include Library - Add .ZIP Library
ausgewahlt. Im Datei-Explorer wird der herunterge-
ladene Ordner ,i2c-Is_arduino_lib.zip” ausgewahlt.
Bei erfolgreicher Installation erscheint im Terminal-
bereich die Ausgabe ,Library installed”. AuBerdem
stehen jetzt im Bereich File > Examples - 12C-LS
mehrere Code-Beispiele zur Verfligung (Bild 9).

Bild 9: Code-Beispiele der [2C-LS Bibliothek Die Bibliothek fur den im ELV Applikationsmodul
Temperatur und Luftfeuchte (ELV-AM-TH1) verbau-
ten Sensor TI HDC2080 kann direkt aus der IDE he-
raus installiert werden. Dazu wird der Library-Ma-
nager aus der Seitenleiste gedffnet. Durch Eingabe
des Sensornamens erscheint die Bibliothek ,Lime
Labs HDC2080" die Uber den Button ,Install” hinzu-
gefligt werden kann (Bild 10).

Auch die Bibliothek fir den im ELV Applikati-
onsmodul (ELV-AM-AP) verwendeten Drucksensor
Bosch BMP581 kann Gber den Library-Manager her-
untergeladen werden. Durch Eingabe der Sensorbe-
zeichnung erscheint die ,SparkFun BMP581 Arduino
Library”. Diese wird analog zur HDC2080-Bibliothek

Bild 10: Installation der HDC2080-Bibliothek (iber den Library-Manager installiert.
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Bild 11: Ansicht eines neuen Arduino-Sketches

Bild 12: Defines fiir die 12C-Adressen und die Angabe
derangeschlossenen Sensoren

Bild 13: Einbindung der benétigten Bibliotheken

Bild 14: Globale Variablen

Bild 15: Initialisierung des Helligkeitssensors OPT3100
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Beschreibung der Firmware

Fir das Auslesen der Sensorwerte wird in der
Arduino IDE unter File - New Sketch ein neuer
Sketch angelegt. Dieser beinhaltet bereits die bei-
den Funktionen ,setup”und ,loop”(Bild 11). Innerhalb
der setup-Funktion befindet sich spater der Code
zur Initialisierung der Seriellen Schnittstelle und der
Sensoren (einmalige Ausfiihrung nach Programm-
start). Die loop-Funktion beinhaltet das zyklische
Auslesen der Sensoren und die Ausgabe der Werte.

Vor dem Beginn der eigentlichen Implementie-
rung werden Praprozessoranweisungen, auch De-
fines genannt, fir eine bedingte Kompilierung des
Codes definiert. Durch diesen Mechanismus verrin-
gert sich die GroBe des spateren Maschinencodes,
da nur die Bibliotheken, Funktionen und globalen
Variablen der tatsachlich angeschlossenen Applika-
tionsmodule geladen bzw. erstellt werden.

Ein weiterer Anwendungsfall von Praprozessor-
anweisungen ist das Anlegen von Bezeichnern, die
dann im Code an der gewlinschten Stelle eingefligt
werden. In diesem Kontext werden so die I2C-Adres-
sen der Sensoren definiert. Bild 12 zeigt alle erfor-
derlichen Defines.

Die Einbindung der Bibliotheken ist Uber den
Menlpunkt Sketch = Include Library maoglich. Dort
befindet sich am Ende der Liste der Bereich ,Con-
tributed Libraries”, aus dem die Eintrage ,I2C-LS",
,Lime Labs HDC2080" und ,SparkFun BMP581 Ardui-
no Library”ausgewahlt werden. Unter Einbeziehung
der zuvor definierten Praprozessoranweisungen er-
gibt sich der Code aus Bild 13.

Neben den Praprozessoranweisungen werden
zwei globale Variablen fir den HDC2080 und den
BMP581bendtigt (Bild 14).

Da ein modularer Code leichter zu warten und zu
erweitern ist, wird fir jeden Sensor eine separate
Initialisierungsfunktion implementiert.

Fir die Initialisierung des Helligkeitssensors
OPT3100 (Bild 15) wird das Objekt ,12C_LS" aus der
zugehorigen Library genutzt. Die Funktion ,begin”
initialisiert die 12C-Peripherie und weist die Uber-
gebene Adresse zu. Der zweite Befehl startet die
zyklische Messung der aktuellen Helligkeit in einem
Intervall von 800 ms.

Die Initialisierung des Temperatur- und Luft-
feuchtesensors HDC2080(Bild 16) setzt sich aus drei
Komponenten zusammen: Zunachst wird die Seriel-
le Schnittstelle initialisiert und der Sensor zurlck-
gesetzt (Zeile 52 und 53). Es folgt die Konfiguration
des Messmodus, der Messfrequenz und der Auf-
[6sung der Messwerte (Zeile 56-59). AbschlieBend
wird der Messvorgang gestartet (Zeile 62).

In der Initialisierungsfunktion des Drucksensor
BMP581 (Bild 17) wird Gberprift, ob die Verbindung
zum Sensor erfolgreich hergestellt werden konnte
(Zeile 71). Solange dies nicht der Fall ist, wird eine
Fehlermeldung ausgegeben (Zeile 74). Die Ursachen
fir das Fehlschlagen kénnen in einer falschen [2C-
Adresse oder einem fehlerhaft angeschlossenen
Applikationsmodul liegen. Erst wenn die Initialisie-
rung erfolgreich verlief, wird die Erfolgsmeldung
aus Zeile 80 ausgegeben.
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Bild 16: Initialisierung des Temperatur- und Luftfeuchte-
sensors HDC2080

In der ,setup”-Funktion (Bild 18) wird zu-
nachst die Serielle Schnittstelle (UART) mit
einer Bitrate von 115200 Bit/s gedffnet (Zei-
le 87).

AnschlieBend folgen in Abhangigkeit der
zuvor genannten Defines die Aufrufe der
Initialisierungsfunktionen der angeschlosse-
nen Applikationsmodule bzw. Sensoren (Zeile
90-100).

Die ,loop”-Funktion wird automatisch nach
der ,setup”-Funktion aufgerufen. In ihr befin-
den sich séamtliche Ausgaben der Firmware,
wie die Zeit in Millisekunden nach Programm-
start und die formatierte Ausgabe der Sen-
sorwerte. Wie bereits in der ,setup”-Funktion
werden dabei Praprozessoranweisungen ge-
nutzt, um einerseits die GroBe des Codes zu
reduzieren und andererseits die Ausgabe an-
zupassen (Bild 19, Bild 20).

AbschlieBend erfolgt die Ausgabe eines
Zeilenumbruchs sowie der Aufruf der Funkti-
on ,delay” zur Verzogerung der nachsten Aus-
gabe um 800 ms(Bild 21).

Bild 20: ,loop"-Funktion (Teil 2)

Bild 17: Initialisierung des Drucksensors BMP581

Bild 18: Funktion ,setup”

Bild 19: ,loop“-Funktion (Teil 1)

Bild 21: ,loop”-Funktion (Teil 3)
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Bild 22: Auswahl des Boards und COM-Ports

Flashen der Firmware und
Ansicht der Ausgabe
Fir das Aufspielen der Firmware wird die
NodeMCU mit den angeschlossenen Applikations-
modulen Uber ein Micro-USB-Kabel mit dem Com- m
puter verbunden. In der IDE muss dann ,ESP32 Dev  Biid 23: Auswahl des Boards und COM-Ports
Module” und der Port ausgewahlt werden, an dem
die NodeMCU angeschlossen ist (Bild 22).
FallsandieserStellenochnichtdasrichtige Board
bzw. der richtige Port hinterlegt ist, kann dies uUber
die Option ,Select other board and port” angepasst
werden. In dem sich &ffnenden Dialog (Bild 23) er-
scheint das Bord nach Eingabe des entsprechenden
Suchbegriffs. Auf der rechten Seite befindet sich
zudem eine Ubersicht aller verfiigbaren COM-Ports.
Die Firmware kann nun auf die NodeMCU Ubertra-  Bild 24: Buttons zum Verifizieren und Hochladen der Firmware auf die NodeMCU
gen werden. Mithilfe des Buttons ,Verify” wird der
Code zunachst Uberprift und anschlieBend kompi-
liert (Bild 24, rot). In der Output-Konsole sollte dabei
keine Fehlermeldung erscheinen, sondern lediglich  Fazit und Ausblick
die Auslastung des Speichers (Bild 25). Sofern der Indiesem Artikel wurde das Erweiterungsmodul NodeMCU vorgestellt.
Vorgang erfolgreich war, kann die Firmware nun in  Nach einer kompakten Definition des Begriffs,NodeMCU"und einer Be-
den Speicher der NodeMCU geladen werden. Dies schreibungdes Schaltbilds wurde auf die Firmware fir die Verwendung
geschieht iber den ,Upload”-Button (Bild 24, blau). der Applikationsmodule Temperatur und Luftfeuchte (ELV-AM-TH1),
Die Ausgaben der NodeMCU kdnnen nun im Se-  Luxmeter (ELV-AM-LX1)und Luftdruck (ELV-AM-AP)eingegangen. Ins-
riellen Monitor eingesehen werden. Dieser wird gesamterdffnen sich durch die NodeMCU und das Erweiterungsmodul
Uber das Menl Tools > Serial Monitor gedffnet und  in Kombination mit den ELV-Applikationsmodulen neue Mdglichkeiten
zeigt fortlaufend die gemessenen Sensorwerte an  zum Messen, Speichern und Weiterverarbeiten von Sensorwerten.
(Bild 26). Neben dem integrierten Seriellen Moni-
tor eignen sich auch weitere Tools wie PuTTY oder

HTerm zur Uberwachung der Ausgaben [12],[13]. Geréate-Kurzbezeichnung: ELV-EM-NodeMCU
Damit der Zeitstempel bei O beginnt, kann der Re- = Umgebungstemperatur: -10 bis +55°C
set-Button auf der linken Seite neben dem Micro- % Abmessungen (B x H x T): 33x52x16 mm
USB-Port der NodeMCU betatigt werden, um einen = Gewicht: 9g

Neustart auszuldsen.

Abb. 25: Ausgabe bei erfolgreicher Uberpriifung und Kompilierung des Codes
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Bild 26: Ausgaben des Seriellen Monitors
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"I Weitere Infos

[11 ELV-Temp-Humi Applikationsmodul Temperatur und Luftfeuchte, ELV-AM-TH1: Artikel-Nr. 157134

[2] ELV-LUX1Applikationsmodul Luxmeter 1, ELV-AM-LX1: Artikel-Nr. 158467

[3] ELV-AirPressure Applikationsmodul Luftdruck, ELV-AM-AP: Artikel-Nr. 156996

[4] Espressif Systems SoCs: https://www.espressif.com/en/products/socs

[5] NodeMCU und ESP8266 - Einstig in die Programmierung:
https://www.mikrocontroller-elektronik.de/nodemcu-esp8266-tutorial-wlan-board-arduino-ide/

[6] ESP-WROOM-32: https://www.bastelgarage.ch/esp32-esp-wroom-32

[71 Joy-IT Entwicklungsplatine NodeMCU mit ESP32: Artikel-Nr. 145164

[8] Download Arduino IDE: https://www.arduino.cc/en/software

[9] Installation der ESP-Bords in der Arduino IDE 2: https://www.youtube.com/watch?v=t4Nu50n0QkA

[10] CP210x-Treiber: https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers?tab=downloads

[11] ELV Bausatz Lichtsensor OPT3001 mit I2C-Schnittstelle I2C-LS: Artikel-Nr. 152106

[12] Download PuTTY: https://www.putty.org/

[13] Download HTerm: https://www.der-hammer.info/pages/terminal.htmi

Alle Infos finden Sie auch online unter: de.elv.com/elvjournal-links
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